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PREFACE

When Acorn brought to market their new range of 32-bit computers and their RISC OS
operating system, they included a suite of four programs:

Paint, a simple bitmap art package

Edit, a basic text editing program that could load and display the contents of any file, of
any type that you loaded into it

Maestro, a simple and rather limited music scoring program

Draw, a surprisingly powerful vector drawing program

A young engineer and programmer by the name of Jonathan Marten liked Draw but felt it a
little limited for his use, so DrawPlus was eventually born. This was offered freely but if
you used and liked it, a donation of £5 was asked for and in return you received a disk
containing several of Jonathan's other programs, in addition to the latest version of
DrawPlus.

DrawPlus came to the attention of a commercial company, 4Mation, who commissioned
Jonathan to write a further version with even more "bells and whistles". This was called
Vector.

Although 4Mation still sold the Vector program, with the decline of the commercial Acorn
market, they had no reason to continue its development.

Jonathan wanted to find a way to preserve the program (which many people still used and
found useful) and to have it ported to the newer generations of RISC OS hardware and
emulators. Not having the resources to do so himself, he decided to release the program
sources to the community in the hope that someone would be able to do a 32-bit port and
develop it further, under the name "OpenVector ", to avoid confusion with the official
4Mation product. This challenge was taken on, initially by Neil Spellings and is currently
maintained by Christopher Martin.

Unfortunately, although the program sources were released and ported, the

copyright of the original printed manual, which 4Mation supplied with copies of the
program, still rests in the manual's author, Mike Matson. Very few copies of the original
manual still exist and all attempts to get in touch with Mike to obtain permission to make
further copies have failed so it was decided that a new manual was required. The old
manual was also rather out of date and did not include many of the later developments.

Thanks go to Mike for his original manual, which has allowed me to get to grips with the
program and also to Jonathan Marten for permission to use chunks of the DrawPlus
manual. Thanks also to Brian Bailey for his help and encouragement, without which this
manual wouldn't have happened.

Special thanks go to Paul Beverley for proofreading and correcting my errors [well, most
of them! PB].






Introduction

1.1 Very basic basics

RISC OS computers were originally supplied with a comprehensive printed User Guide/
Applications Guide detailing their use and operation and including a 50 page Tutorial on
using Draw. It is appreciated that those coming to RISC OS via one of the emulators or
Raspberry Pi will not have that benefit, so a few basics will be mentioned here.

The idea for a graphical user interface, which we are now familiar with in its various
forms, originally came from Xerox Parc back in the early 1980s. It was adopted by many,
including Apple and Microsoft, but only Acorn stuck to the original three button mouse.

In the Acorn environment they are referred to as, left button — select, middle button —
menu, right button — adjust. Clicking on the menu button anywhere on the screen will
always bring up a context-sensitive menu.

In this manual, whenever you see select, adjust or menu, or a key combination, in italics it
means that button/key combination should be pressed.

The iconbar is the narrow strip along the bottom of the screen that shows the drives
available and the icons of any loaded applications.

RISC OS includes a protocol known as OLE: object linking and embedding. This allows
one application to automatically call up another to carry out certain tasks. This is supported
by many applications including Impression and Ovation Pro (document processors)
OpenVector and Acorn's own applications.

If, say, an OpenVector created graphic has been loaded into a frame in Impression,

Ctrl (Control)-double-clicking over the graphic will cause OpenVector to be loaded with
the graphic, so that editing can be carried out. Saving from OpenVector will cause the
modified graphic to appear back in the Impression frame from whence it came.

The ! character precedes the name of all RISC OS programs as it signifies to the OS that
any directory starting with ! is an application and the OS should look inside it to find the
files necessary to run that application.

Much more information on RISC OS can be found here:
https://www.riscosopen.org/wiki/documentation/showIntroduction%20to%20RISC%200S

Also useful is
http://www.riscos.com/support/users/userguide3/book2b/d_5.html

For further information and help regarding OpenVector , I would recommend subscribing
to the OpenVector mailing list: http://www.torrens.org/Lists/OpenVector /faq.html

Note that the exact appearance of window furniture may be different in different versions
of RISC OS.
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1.2 First Time
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When OpenVector is run for the first time, an open Window will appear as above.

Across the top is the title bar with two small icons at each end. The one on the extreme left
will cause the window to be put behind any other window which is open on the screen.
The X icon next to it will close the window. If you have any unsaved work, a warning
message will appear and you should take action accordingly. The icon on the extreme right
will cause the window to occupy the whole of the screen and the one next to it will
"iconise" it. You will see it reduced to a small icon pinned to the pinboard (desktop). This
can be re-opened with a double-select-click on this icon. Below that is the information bar.

Put window behind Full screen
’7 Close window Iconise *‘
= B OpenVector: Untitled [=]=
,m[ Create mode: Open line | Standard /
Status information Current layer

The function of the slidebars at the right and bottom edges is fairly obvious, and the small
icon in the bottom RH corner allows the window to be resized by dragging. Down the left-
hand side is the toolbox.
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OpenVector has many, many features, and these are accessed by using a combination of
the toolbox and context-sensitive menus, which will appear whenever the menu button is
pressed.

Drawing is accomplished by simply drawing on the screen with the select button pressed,
and much editing is also done directly with the mouse. The toolbox provides quick access
to a number of features using either select or adjust, and many keyboard shortcuts are
available to speed access to menu items.

Keyboard shortcuts: F6 is function key 6, 1 F6 indicates the shift key should be held down
while F6 is pressed, AF6 indicates the control key should be held down while pressing F6.

A full list can be found here:
http://diy.torrens.org/RO/Vector/Keys.html
This manual is structured around the main menu, and all the features will be considered in

the order in which they appear on the main and sub-menus, reference to the toolbox being
made as required.

1.3 The toolbox

The toolbox itself is illustrated here, with tools labelled

=]

Current file type

Create straight path (open) ! Abandon operation

R <

Create straight path (closed) Select tool

!
<
Create curved path (open) £.f
&?

71 Edit mode
Create curved path (closed) Library mode
Insert move T| Enter text
Create arc f.|%4| Magnification
Create 4-point curve { 3| #| Movement constraint on/off
Create rectangle [Jif\J| Drag setting
QC

Create elipse Set origin mode

g3
*n

Create polygon Toggle grid lock/Open rulers

Select higher layer Select lower layer

H
L8]

Graphics level control
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Most icon titles are self-explanatory but will be looked at in greater detail later. However,
it is useful at this point to look at some of the menu options, before starting any drawing,
as these are used to set up some of the basic parameters.

1.4 The Main Menu
Menu clicking over a new OpenVector window will bring up the top level menu.
The menu entries all have right pointing arrows by them, indicating that there is an
attached sub-menu. Additionally, some have a key indicated, e.g. F6. This indicates the

keyboard shortcut to this menu. Some at this point are "greyed out" as they are not
applicable to a blank drawing.

OpenVector
File [
Drawing P
Dasplay p-
Create -
|v Select F6 P
Edit F5 P
Library TF6 I~
Arrange P>
PatiyMask &
Special [
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2.1 The file Menu

The file menu controls file saving and printing options. It can also be brought up by menu

The File Menu

over the filetype indicator in the toolbox.

File

Info =
Save F3 P
Options |
Export 13
Print... PRINT
Setup... TPRINT
Save defmults

2.2 Info

The file info leads to information about the file as created.

About this file [=

Top-level objects | 3
On current layer |
Included objects |

=]

A4

Size[ 272
[ Modified |

[
Left | 4.20cm
Bottom | 15.60cm
Width I 2.84cm

Right | 7.04am
Top | 18 24cm
Height | 2.64am

Indicates the file type is Openvector .

10



The File Menu

2.3 Save
File

Info P Save as:
N
Options P
Export fE3 > VectorFile|
Print... PRINT szceljl Save |
Setup... TPRINT

Save defaults

When selecting "save" you will be presented with a small dialogue box with a default
filename already in it. This can be cleared with Ctrl-U, and you then type in your own
filename. The dialogue box will also have a small icon representing the type of file you are
saving. In order to tell the computer where you want to save the file, this icon needs to be
dragged to an open directory (=folder).

Early versions of RISC OS had a ten-character filename length restriction, so the box is
small but will automatically scroll as the name is typed. File type information is held
within the file itself so no filename extension is required. The Vector file symbol is then
dragged to an open directory window where the file is to be saved. OpenVector will
remember the full file path so subsequently it is only necessary to select "Save".

Subsequently, you will get the same dialogue box but the filename and path will already be
filled in, so it is only necessary to "select" "OK". The filename can be edited if required, so
"myfile" could be changed to "myfilel" before selecting "OK". Additionally, if required,
the file could be saved to a different directory by having a different directory open and
dragging the file icon as before. The new path details will be changed automatically and
remembered.

Dragging the icon onto the open window of another application, Impression for example,
will import the file directly into that application. Dragging into another OpenVector
window will merge the first drawing with the second.

Existing files may be loaded by dragging the file onto the OpenVector icon on the iconbar,

into an empty OpenVector window or, if OpenVector has been "seen" by the filer, select-
double-clicking on the file itself.

11



The File Menu

OpenVector can load the following filetypes

Vector: created by Vector or OpenVector

Draw: created by Vector or OpenVector , Draw, Draw+, or other applications
Compressed Draw: created by Vector or 4Mation's Chameleon

JPEGs can optionally be converted to sprite files on loading

Poster: created with 4Mation's Poster application

Sprites: Acorn bitmap format

Text
Save Options
Format k
w (® Vector _) Draw
_J) Compress ) Poster
Auto Save
_l Auto-sive every 11} | minutes
Prompt before auto-saving
Beep when auto-saving
Cancel l | OK I
2.4 Options

2.4.1 Format The default format (file type) would usually be Vector, as this preserves all
the information about the drawing. If this is changed, the current filetype icon in the
toolbox will change to reflect this change.

For example, instead of I-\#'I one might see @ representing a Draw file.

2.4.2 Draw This allows the drawing to be imported into any other RISC OS applications
which understand Draw files. For example, imported as a graphic into a Word processor/
desktop publishing package, Draw or Draw+. However, there can be issues with certain
types of special objects which can be created in OpenVector and are not understood by
other applications.

2.4.3 Compress. this saves a compressed Draw file. In the days when the only option was
saving to a floppy disk, this was useful but today, with large hard drives, hardly necessary.

2.4.4 Auto-save and a time selection, clearly useful for when the unexpected happens!

12



The File Menu

2.5 Export

Export

Vector

Compress
Draw
Poster

- O A A

This behaves in a very similar manner to the Save option but allows a selected item within
the drawing to be exported. Although the options in the lower panel appear greyed out in
the above, they will be active if the object selected is one of these types. For example, if
the selected object is a sprite, the option to export as a sprite will be available.

2.6 Print

The Print dialogue box is shown below.

Print
Driver [ UniPrint
Resolution [ 300 x 300
Options
Number of copies 1

_| Collate multiple copies
_| Reverse order of pages

_| Manual paper feed

Generate EPS illustration

Cancel | Prmt |

The entries at the top show the driver being used and its resolution setting. The latter is set
via the printer driver itself and not here. A printer driver must be loaded for this
information to appear.

13



The File Menu

2.6.1 Collate multiple copies OpenVector has the ability to print a large drawing across a
number of pieces of paper (see 2.7 setup). If the number of copies to be printed is greater
than one, they will normally be printed in the order of p1, p1, p2, p2, p3, p3 etc. Selecting
Collate changes the order to p1, p2, p3, .... pl, p2, p3.... This, however, will be much
slower if a laser printer is used because normally the data for each page is downloaded into
the printer's memory and x pages printed before the next lot of data is loaded. With
collation selected, each page and each repeat page will be downloaded separately.

2.6.2 Reverse order changes the order in which pages are printed. Instead of p1, p2, p3, it
will print p3, p2, pl.

2.6.3 Manual paper feed means that after each page, printing will be paused and the
computer will wait until you confirm the printing of the next page. This could be used, for
example, if you wish to print double-sided on a non-duplex printer. The first page would
be printed, turned over and presented to the printer, and printing of the next page
confirmed.

2.6.4 Generate EPS illustration. This option is shown greyed out in the above illustration
but will be available when a Postscript printer driver is selected. A Postscript level 2 driver
is normally included with RISC OS in the Printers directory but a level 3 driver can be
obtained from

http://www.mw-software.com/software/ps3/ps3.html

2.6.5 Printing files. As long as OpenVector has been "seen" by the filer it is not necessary
to load OpenVector first. A file from a directory can simply be dragged to the printer driver
on the iconbar. OpenVector will automatically load, the file will be printed and, if "Quit
after printing" has been selected (13.3.9), quit.

2.7 Setup
' Page Setup '

Position

| Print scale 100%]
Honzontal offset 0.00cm
Vertical offset 0.00cm
Orientation

I (® Normal ) Rotate 90°

1 1 page All J Nunf:J
Cancel | Options. .. I | OK |
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Most of the print setup is concerned with the way large drawings can be printed on
multiple sheets of smaller paper. The printer driver needs to be loaded first.

The preview pane shows the area to be printed, in white, using a single sheet of A4 paper,
of an A2 drawing at 100% scaling. By changing the scale it would be possible to force the
drawing to fit on a single A4 sheet but this may be undesirable. The Options button leads
to a set of options allowing multiple sheets to be used.

The horizontal and vertical offsets allow a different area to be printed, as below.

Position

Print scale 100
Horizontal offset 10.00cm
Vertical offset 10[00cm
Onentation

(® Normal _J) Rotate 90°

1 page All ] NUI'I.EJ

The same effect can also be achieved by clicking adjust in the preview pane, when the
point clicked on will define the left-hand bottom corner of the printed area.

2.7.1 The Options menu interacts strongly with the set-up menu and it will necessary to
switch between them to see the effects.

Print Options
Options Page order

_| All pages (for entire sheet area) (® Across

) Down
I? Show pages on drawing

Sh top of object
—| il g St s Use “Choices” to

I? No font blending sel Ihl? paper
margm and
I? Print skeleton objects

skeleton colours,
| Print "Thin' lines as width 25

Cancel | Pages. .. I OK I

15



The File Menu

2.7.2 All pages will print the entire sheet using as many sheets of paper as required.
Selecting Pages will return to the previous Page Set-up, where orientation can be chosen,
and the effect will be visible in the preview pane.

4 4
1 z
z J
3 § 3 b
All pages normal All Pages 90°

Clearly, all pages 90° would be rather wasteful in this case.

2.7.3 Page order affects the order in which pages are printed. If roll paper was being used,
selecting the order 1,3,2,4 would result in less cutting of paper to tile the drawing together.

2.7.4 Show pages on drawing results in the page margins being visible on the original
drawing itself. The colour of these margins can be chosen from the Choices menu (13.5).

2.7.5 Show on top of objects Normally the page margins will be shown on the
background and objects will be drawn over the top. This option allows the page margin
line to "jump forward" as it were and to appear in front of the objects.

2.7.6 Font blending This affects how a font reacts with the background it is placed on.
With blending on, hard edges are softened and gently merged into the background. The
effect is only really noticeable with coloured text against a coloured background.
(10.34.1)

2.7.7 Print skeleton objects Skeleton objects are dealt with later in the manual (12.9).
2.7.8 Print 'thin' lines as width. Line thickness selection is dealt with later but if "thin"
lines are used on a drawing they can cause issues when the file is printed. Depending on
the printer driver and printer used, they can become virtually invisible. This allows

automatic thickening to a defined size.

2.7.9 Pages will return to the Page setup menu and the effects of the selections made can
be observed in the preview pane.

16



The File Menu

2.7.10 None may seem a strange option but in effect it clears the pages to be printed but
leaves all pages shown. It is then possible to select individual pages to be printed.

In the left-hand example below, pages 1 and 2 only will be printed. This would be useful if
only one or two pages of a drawing needed to be printed.

In the right-hand example, a green square can be seen. This represents the border of all the
objects in the drawing and only the two pages covering the objects need to be printed. If
necessary offsets can be applied to make a better fit and reduce the number of pages to be
printed.

17
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The Drawing Menu

3.1 The Drawing menu

Drawing
Rulers... AF6
Layers... fIF5
Dashes.., AF5

Page size... "FJ
Simple setup

Tidy objects
Check boxes

3.2 Rulers

Rulers

Ruler
(g A SR - S

Scales
Drawing

centimetre ﬂ

= -

User | 1 centimetre El

(]

Divisions | 0.20cm

Misc Units

Line width point il
Text size point El
|

Scale factor Percentage

Gnd...

Cancel

b

Rulers are a very important feature if a drawing is to be made to a specific size, such as an
engineering drawing, and they can be made to scale. Up to four different rulers can be used
in any drawing, selected by the buttons 1 to 4.

20



The Drawing Menu

3.2.1 Scales allows scale rules to be generated. The first shows the actual units and size
used on the drawing. The default shown means a 1cm line on the screen will be a 1cm line
when printed, within the limits of the printer and the conversion done by the printer driver.
The actual units can be selected by the drop-down menu to the right.

OS unit refers to the units used by the operating system internally when drawing on the
screen.

The lower shows the scale of the rule to be used. The default shown would be a 1:1.

It is perfectly possible to have mixed units within the scaling. If you are into model
railways, for example, the following entry would give you a ruler scaling 4mm to the foot.

Rulers

Ruler
@ e s (NSt e

Scales
Drawing | 4 millimetre | *F]
User | 1 foot EI

Divisions | 12] |[ 008 &

In order to display the ruler on the drawing it is necessary to go to "Display>Show rulers"
(4.1) from the top level menu, or the keyboard shortcut Ctr/-P can be used.

Note that if the selected divisions are very close together they will only be shown when the
drawing is zoomed in sufficiently to make them clear. At lower magnification only every
second fine division may be shown, for example, so you may see only six divisions to the
foot and pro rata. When active the pointer position is shown on the ruler by a red line.

21



The Drawing Menu

Red line indicates pointer position on ruler

I
Wr 'Actual size
0 5
! IIII|IIII|IIII|=III|IIII|IIII|IIII|II
!E! s
Red line indicates pointer position on ruler |'Z _:
e %]
oty ]
=
A = R
SEE
OO SN ™
O’!+’ =
S ==

3.2.2 Misc units allows setting of the default units used for line width and text size, by
choosing from the drop-down menus to right of each box. Point and Pica both refer to size
units used in the printing industry. Pica is equivalent to twelve point, about 1/6th inch or
4.2mm. Scale factor relates to how scaling is done when an item is resized, percentage or
decimal. This will be dealt with later (9.5). In the lower section, apart from "Cancel" and

"OK", whose meanings are obvious, there are two buttons leading to further choices,
"Origin" and "Grid".

22



The Drawing Menu

3.2.3 Origin Whilst the ruler origin is normally the bottom left-hand corner of the visible
screen, it can be set to be elsewhere by setting co-ordinates to offset from this point, or
choosing a preset position from the "set to" drop-down menu. See also 7.12.

Origin
Ruler K
@ =3 OE O
Position
Horizontal | 0.00cm| Setto *H|

Vertical | 0.00cm | Setas default |

Options

(® Common origin for all rulers

) Independent origin for each ruler
| Allow repositioning (Shift-Adjust)
_| Show position on drawimg

Rulers. .. I
Cancel |

3.2.4 Allow re-positioning When this is selected, the origin can be changed directly from
the main screen. If the mouse pointer is positioned at a point over one of the rulers, and the
adjust button clicked while holding down the shift key, the origin of the drawing will be
reset to the position under the mouse pointer. The ruler will reflect this change of origin.

%

Origin marker

3

Show position on drawing will show the origin marker on the drawing.

23



The Drawing Menu

3.2.5 Grid Menu Inherent in any drawing is a grid, which can be made visible or invisible
and be dots or lines. Even when visible on the screen it is never printed. It is of great
benefit when laying out objects on the screen and, if lock is selected when drawing an
object, the points will automatically snap to the nearest grid point, making it easy to create
objects of exact size. The grid size is determined by the "Rulers" settings. It is also
possible to fix the increments by which an object may be rotated. However, if orthogonal
constraint (4.1.4) is selected, this will take preference over the rotation step. Rotation will
be constrained to steps of 45° for a rectangular grid or 30° for an isometric grid.

This option has no effect on rotation performed via the "Rotate" dialogue 9.2.

Gind k_

I? Create/move/scale to gnid

Lock

I? Rotate to steps of 5 [#
Display
) Points
"_} [ Use “Choices™ to
/) Lines set the grid colour.
(@ No grid
Layout

(o Rectangular (45" angles)
. Isometric (30° angles)
£

Ongm... Rulers. .. |
Cancel l | Ok

3.2.6 Grid lock can also be toggled on/off using the padlock icon on the toolbox | g | and
for most purposes it is best left on.

!

Although the rectangular grid will be used most commonly, there is an option to set an
1sometric grid if isometric drawing is being undertaken.

24



The Drawing Menu

0 50
l_ ||||||||||||||||||||||||||||||| 1_“||||l||||!||||!||||l||||l5|n|||_||
; =_: ................................
L — Ly —
uli s O . S N (T U S
Grid Points Grid Lines
3.3 Layers
Layers
No  MName Sel Vis List
Add layer
| Layer #1 oo J
Delete layer
Select all J
= Select this |
Current View all |
Number View this |
Name Smn{lﬂrdl
Optioes Cancel J
_| Automatic Sel/Vis following [ OK J

Layers is a powerful feature allowing different objects in a drawing to occupy different
layers within a drawing. For example, a printed circuit board could be designed with the
track side on one layer, component side tracks on a second layer and the component layout
on a third layer. This allows the whole board to be viewed as one, or each aspect
separately, and each aspect printed without the other being visible.

25



The Drawing Menu

A drawing can have up to 32 layers. Each object appears on a particular layer, and each
layer can be made visible (i.e. the objects are shown on the screen, or printed) and
selectable (i.e. the objects can be selected and operated on) independently. There is always
a current layer set, on which new objects are created and existing objects can be moved to.

Most aspects of layers are controlled by a dialogue box opened by choosing "Layers" from
the "Drawing" menu or by clicking Adjust on the layer display in the information bar. It
shows a scrolling list of the layers currently defined, with two buttons by each one. When
"Sel" is on, objects on that layer can be selected and operated on; otherwise they cannot be
selected. When "Vis" is on, objects on that layer will be shown on the screen and printed;
otherwise they are invisible. The current layer is shown by the highlight bar; to designate
another one as current, click on the name or number in the scrolling list.

3.3.1 Add layer To define a new layer, click "Add layer"; a new layer will be added with
the first free layer number and a default name. It will also be selected as the current layer.

To change the name or number of a layer, select it as current and then edit the name or
number in the boxes below and press Return. If the number is changed, and the new
number is already defined as a layer, then the two layer names and information will swap.

3.3.2 Delete layer To remove the definition of a layer, select it as current and then click
"Delete layer". Any objects that were on deleted layers will, when the operation is finished,
be moved to layer 0.

3.3.3 Select all To select objects on all layers, click "Select all", the equivalent of selecting
each item under the "sel" column. To select only the current layer and layer O, click "Select
this".

3.3.4 View all To view objects on all layers, click "view all". The equivalent of selecting
each item under the "Vis" column. To view only the current layer and layer O, click "View
this".

When all the layer settings are as required, click "OK". Press Escape or Cancel, or click
the dialogue box's close icon to abandon the dialogue and not change any layer settings.

Any new objects will be created on the current layer. To change the layer of existing
objects, select them then use the options under "Arrange>change layer (9.6) to move
them.

When an object in the current layer is selected, it will be surrounded by a box made up of

one colour (red is default) squares. If an object is selected in a layer which isn't the current
one, the squares will be yellow (default). These colours can be set via the "Choices" menu
(13.5).

26



The Drawing Menu

Layer number 0 (default name "Standard") is slightly special. This is the layer that will be
used by default if no action is taken to define new layers. Files created by Acorn Draw and
other applications, will have all their objects on layer 0. Any objects on layers that are
deleted, or objects merged from a file whose layers are not defined, will also appear on
layer O. This layer cannot be deleted or renumbered.

If you intend to create a layered drawing, It is recommended that you reserve layer O for
unlayered objects and use layers 1 through 31 as required.

Layer numbers are important if layered objects are to be transferred between drawings or
drawings merged into one another. Objects will be transferred onto layers with the same
number, regardless of the name; if a layer is not defined in the drawing that the objects are
being merged into, any objects on that layer will appear on layer 0.

3.3.5 Automatic Sel/Vis following When this is selected, the layer options (visibility and
selectivity) are automatically copied through from one layer to the new one when the
toolbox icons are used.

Toolbox Icon used to step between layers: | & | W

For example, when moving from a layer where both "selectable" and "visible" are
operative, to a different layer which perhaps only has "visible" set, the settings will be
changed to those of the previous layer, "Selectable" and "visible". The layer moved from
will have the properties the layer moved to had previously, i.e. it will become "visible"
only. Moving back will reset the situation back as it was before the first move.

3.4 Dashes

There are a number of standard dash patterns available for when drawing lines these can be
viewed and edited via this option.

Select one of the ten patterns available with the left or right arrows. Select in the upper
(edit) area to change a dot from black to white or vice versa. Adjust over the red section to
set the repeat length of the pattern; the area available for editing is that to the left of the red
bar and the pattern repeats after this, if necessary.

An actual size view of the pattern is shown in the sample area. Click "OK" to store the
edited patterns.

Drash patterns k
Edit
(O R
Pattem Sample
= - || [ E—— Canoelj | OK J

Note that editing a pattern does not change the appearance of any existing objects using
that pattern.
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The current patterns are normally saved with the drawing, unless the "settings" save has
been disabled.

3.5 Page size
Page size is fairly self-explanatory, with page sizes being selected from the drop-down
menu. If "Show pages" — "File>Print setup”, (2.7.4), is selected, a grey area will be
visible in the drawing window, representing the area which cannot be printed. (Most
printers are unable to print over the whole area of the paper.)

3.6 Simple set-up

A single page will be printed at 1:1 scale with page area and margins as defined by the
printer driver. The drawing's paper size will not be changed.

3.7 Tidy objects
This facility will "find" objects that may have strayed outside the document area. This can
happen if a document has been reduced in size. Full view (4.1.3) should be used to check
which objects may have moved.

3.8 Check boxes

This checks the bounding boxes (6.1.1) (12.6) of all objects and corrects them if they are
wrong. This can sometimes happen with imported objects from other applications.
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The Display menu

4.1 The Display menu

Display
Scale view Y
Enlarge PAGE UP
Reduce PAGE DOWN
Full view HOME

Constraint L ]
v Comer-Comer
Centre-Comer

About origin

¥ Show status Fl

v Show tools F2
Show rulers Ap
Show palette L

v Auto scroll
v Dithering

4.1.1 Scale view menu

Scale view

Scale | S0 | N/ %

0% | 20% | 50% |

200% | 500% | 1000% |

_l Zoom Close

The scale view menu allows selection of the display magnification. It has no effect on the
scale of the drawn objects but allows higher screen magnification to view/create fine
detail.

The same menu can be obtained by clicking adjust over the magnify icon in the tool bar.
4.1.2 Magnify icon |3|
Select, when pressed over this icon, will cause the screen magnification to toggle between

the figure selected in "Scale view" and 100%. The "zoom" button on the scale view menu
has the same effect, as does the shortcut key Ctr/-Y
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4.1.3 Enlarge, Reduce, Full view The page up, page down and home keys are active the
whole time a drawing is being worked on. Page up and page down cycle through a series
of fixed magnifications. these are:

5 7 10 15 20 25 33
50 66 75 100 150 200 250
333 500 666 750 1000 1500 2000

Home causes the whole drawing to be displayed "full view" in the window regardless of its
size.

4.1.4 Constraint 3| This can be selected from the toolbox or with the shortcut Ctrl-O.

When selected, pointer movement is restricted to 90° or 45° (rectangular grid) or 30°
(isometric grid) while dragging. This can be used, for example, to force the ellipse or box
tools to create a circle or square. It will also force the path create modes to draw horizontal
or vertical lines, or at an angle determined by the grid in use. Select mode dragging will be
similarly constrained.

When objects are scaled by dragging a corner tab (7.1.1), scaling is constrained to be
proportional.

4.1.5 Corner to Corner, Centre to corner

This affects the way in which an object is scaled by dragging. This behaviour can be
toggled with the icon immediately below the constraint icon on the toolbar. It changes its
appearance according to the option selected.

] N

centre to corner  corner to corner

When centre to corner mode is selected and an object scaled by dragging a corner tab, all
four corners move a corresponding amount. If scaled by moving the centre tab on a side,
the opposite side, and only the opposite side moves as well.

When corner to corner is selected and the object scaled by dragging a corner tab, the

opposite corner remains fixed. Similarly, if an object is scaled by dragging the centre tab
on a side, the opposite side remains fixed.
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- :
||
[ | m B ]
| |
[ ]
Centre to corner mode Corner to corner mode

4.1.6 Origin |+—;I

When an object is scaled by dragging a corner tab and the origin mode is on, the object is
also moved relative to the origin. Both the size of the object and its distance from the
origin are scaled by the same factor.

Object dragged using top right corner tab

.| Original object
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4.1.7 Show status, Show tools, Show rulers, Show palette affect the visibility of these
items on the screen.

4.1.8 Auto-scrolling. When a small area of a drawing is shown and a line being
constructed approaches the edge of the window, auto-scrolling allows the window on the
drawing to move relative to the drawing to allow the line to be shown in full.

4.1.9 Dithering allows older machines using limited colour modes, to display a closer
representation of colours not otherwise available. An approximate representation of a
colour only normally visible in a 256 colour mode can be shown in a 16 colour mode.

4.2 Graphics level control H

This does not form part of the menu but is accessed directly from the toolbox. It controls
the amount of detail shown in a drawing. Large complex drawings can take a long time to
load or move about the screen. By reducing the detail shown, this can be speeded up. At
level 1 objects are represented by simple boxes whereas at level 5 all detail is shown. This
is more relevant to old, slow machines rather than modern hardware such as the ARMX6
and Titanium class machines.

The detail printed out is unaffected by this setting and full detail will always be printed.
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5.1 The Create menu

All the items in this menu, as well as being accessible via keyboard shortcut, are available
directly from the toolbox (1.3) and can be divided roughly into lines and shapes, all of
which consist of paths and segments.

Create
Box AF10
Ellipse ARD
Polygon AF11 =
Text T

Bezier TF10
v Lme Fl10
| Arc ATA
4-point ~iB

v Closed fiF11

5.2 Box @

If corner to corner mode is selected (4.1.5), a rectangle can be drawn in two ways. Select to
mark one corner, move to the opposite corner and select again or select to mark one corner
and continue to hold the button down while dragging out the shape as required. When the
mouse button is released the rectangle will be drawn.

If centre to corner is on, select double-click to mark the centre and then move out to select
the corner or select once on the centre and continue to hold the button while dragging out a
corner, releasing to complete the operation.

If constraint mode is on, a square will always be drawn.

5.3 Ellipse | Q)

The creation of an ellipse follows the same procedure as drawing a rectangle, and
constraint mode will result in the creation of a circle. Because of the way we normally
think of circles they are usually easier to draw when centre to corner mode is selected
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5.4 Polygon |{}

When drawing a regular polygon, it is first necessary to select the number of sides. It will
be noticed that the entry in the create menu has a sideways arrow leading to a dialogue
box. This allows the selection of the number of sides from 3 to 100. The same dialogue
box is brought up by clicking adjust over the polygon tool in the tool box. Again, polygons
are usually easiest to draw in centre to corner mode.

5.5 Straight lines open I;l

A straight line can be composed of a number of segments as shown.

_'|_

2
This shows a line in the process of being drawn. The point represented by the small circle
is the starting point generated by clicking select at that point and, by moving the mouse
and clicking select at other points, the segments shown are created. The final point is that
shown with the cross. By moving on and clicking, further additional segments can be
created. If, however, select is double-clicked, this will complete the drawing of the line,

whilst using the adjust instead of select will complete the line but immediately enter Edit
mode (7.1.2).

The Delete key will operate in two modes. If a point has just been clicked and not moved
away from, the point prior will be deleted. If the pointer has been moved away, as if to
draw another segment, it will be the point last clicked that will be deleted.

5.6 Straight line closed |[/%

This tool behaves in exactly the same way as the open line tool, except that when the line
drawing is completed, a new segment will automatically be drawn, connecting the last
point to the starting point.

5.7 Bezier — open curved line|{.¢

A Bezier curve is a mathematical function used to define the parameters of a curve.
It allows the drawing of curves, which can be infinitely variable yet easily defined.

The tool works in a similar manner to the straight line tool but curves may easily be
produced.

In the example shown, the circle represents the starting point and the cross the current
point as before. The green squares are the points specified by select and the intermediate
yellow are the control points generated automatically to define the parameters of the curve.
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5.8 Closed curve line Iﬁ[

As for closed straight line but the object is completed with a further curved segment.

5.9 Arc Ii[

To draw an arc, simply select one end then move to where the centre should be and make
one further select. Part of an arc is then drawn and if the pointer is "hovered" over the
green box it will be found possible to move the other end. the pointer should remain
"hovered" while this is taking place; do not try to click on the box. When the other end of
the arc is in the proper position double-click select to complete the drawing

: i'._ Current poition of pointer

Starting point |

5.10 Four point curve |1y

The construction follows the same general rules. Starting with the first, the other points are
added. If the last point is marked with a single select, it is possible to go on to define
further points. If a double-click select is used, the object is completed

In the "Four point with extension", the original four point curve is shown feint grey and the
continued extension is the green curve. When completed it will be one path.
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5.11 Move |

During the construction of a path, the create menu can still be opened and a different
selection chosen. The same can be done using the toolbox selections. It is thus possible to
start a path with a straight line tool and then change to the Bezier tool. Another very useful
option is the "move", which will effectively create an invisible segment in a line. This still
remains as one line; it is not broken by the move operation.

Other operations within this menu allow an open path to be changed to a closed one, finish
the path or delete the last segment.

= m %

" .
m

. B -
© o

Straight line with added Bezier . Line with move showing invisible segment .
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The Select Menu

6.1 The Select menu

Select
All nA
Beverse ahT
Invert AN
Clear N
Delete AX
Copy i s
Order ATO B
Group MG
Lock AH
niae

v Select by click
Touch

v Enclose
Centre

6.1.1 Once an object has been created, there are many things that can be done with it but
first it must be selected.

Select tool K

With the select tool in operation, move the pointer over an object and click the select
button. Selection will be shown by the appearance of a box drawn around the object,
having tags in each corner and one along each side. This box is the object's "bounding
box", normally invisible but made visible by the act of selection.

If select is chosen immediately after drawing an object, that object will automatically be
selected.

If the wrong object is selected, moving the pointer over a different object and select-
clicking will select the new object and deselect the old one. To select a new object without
deselecting the first, use adjust click over the second object. Any number of objects may
be selected using this method. To deselect an object without selecting another, click adjust
over the selected object.
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If an object you wish to select lies within the bounding box of another, select may cause
the first object to be selected. Double-clicking select will cause the first object to be de-
selected and the second object selected. In the case of multiple objects, it is a matter of
double-clicking select each time until the required object is selected.

When it is required to select more than one object, the first is selected as above and then
adjust is used. If, because of multiple objects being stacked, this is not the object required,
select double-click is then used to select the required second object. Adjust can still be
used to deselect objects if required. Practice is necessary with these operations to fully
understand how the system works, but quite complicated multiple level objects can be
selected.

6.2 Select by box
An alternative method of selecting objects, particularly useful if a number of objects are to
be selected, is to select-click a little away, in free space as it were, and, holding the mouse
button down, drag out a box around the objects. The selection behaviour depends on the
option chosen from the three options at the bottom of the select menu.

6.3 Touch

If touch has been selected, any object whose bounding box touches or intersects the
selection box will be selected.

6.4 Centre

If centre has been chosen, then if the centre of a bounding box falls within the selection
box, that object will be selected.

6.5 Enclose

If enclose is selected, only objects whose bounding box is entirely enclosed by the
selection box will be selected.

6.6 All

(Ctrl-A) All will select all objects on the diagram.
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6.7 Reverse
(Ctrl-V) Reverse will reverse the order in which items have been selected.

In the example below, the three objects on the left were selected in the following order:
square, hexagon, circle, as indicated by the numbers within the object. The right-hand
three show the situation after reverse has been applied. It is as if the objects had been
selected in the order circle, hexagon, square.

6.8 Clear
Ctrl-Z clears the selection.
6.9 Delete
Ctril-X deletes the objects selected, as will the Delete key.
6.10 Undelete
Insert undeletes the last deletion.
6.11 Copy
Ctrl-C Copy will cause a copy or copies of the selected item or items to be generated. The
top left-hand corner of the copy or copies will appear a little to the right and below the top
left-hand corner of the original and will be automatically selected. See also 13.4.1.
6.12 Order
Ctrl-Shift-O 1f items are drawn overlapping, the second item drawn will be over the first. If

this is not what is required, the order may be changed from the order sub-menu by
selecting one or more items and making a choice from this menu.

=] Object order 1=
Front AF | Back B |

Forward J Backwardj

Position
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;Drigiﬁal order | | . Boxes re-ordered

6.13 Group

Ctrl-G Group allows several objects to be grouped together; thereafter the group will
appear and behave as one object. However, for certain editing operations it may be
necessary to "Ungroup", carry out the edit and then group back together again. For
example, it is perfectly possible to group graphic and text objects together and move them
around the screen as if one object. However, in order to edit the text part, for example, it
would be necessary to ungroup first before the text edit mode can be used.

6.14 Ungroup
Ctrl-U Ungroups a group of objects.
6.15 Lock/Unlock

Ctrl-H Lock, as its name suggests, protects an object so that it cannot be accidentally
moved or edited. Unlock (Ctrl-E) removes the lock.

6.16 Untag
Tagged objects are special types of objects created by other applications such as Poster
(another 4Mation product). The untag option removes the tags from these objects reducing

the amount of memory required. However, it removes certain special attributes so should
only be done if they are not going to be re-edited in the original application.
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7.1 Editing

Editing can be considered as any process applied to an existing object. OpenVector's
strength is in the wide variety of tools available, and effects that can be applied, both to
graphic and text objects. No one single menu exists for this purpose as will be seen, but
some simple editing is quickly carried out using the mouse. To do this, the first step is to
select the object to be worked on using the select tool from the toolbox (6.1.1).

7.1.1 Select tool X

The desired object can then be selected. If the select is held down for a moment over the
object, the pointer will be seen to change into a hand and, whilst select is held, the object
can be moved around the screen, the object remaining where it has been placed once select
is released.

Delete will delete the selected object, Ctrl-C will make a copy.

If select is held over one of the tabs the pointer will change into a rosette and it will be
found possible to drag the tab, so changing the shape of the enclosed object.

If adjust is used the object can be rotated.

7.1.2 Edit tool | &%

OpenVector has many powerful features for editing objects but first an object must be
selected for editing. Select as described above, then click on the edit tool or keypress F5.

Editing is begun by clicking adjust on one of the green construction points on a line. If the
mouse button is held down, the point can be moved about the screen thus changing the
shape of the object. If the line is a Bezier curve, clicking on and dragging one of the
yellow "intermediate points" will change the shape of the curve.

A segment of the line will be shown in green and this is the segment to be worked on.
Segments may be selected as required by clicking adjust on the points at each end of the
required segment.

e
‘ |
. . =
- |
' |
7l ﬁ: . i {0 :}{
. Editing a siraight line object Editing a Bezier curve
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7.2 The Edit Menu
Edit
Move Fll
¥ Line FI0

Bezier fiF10
Closed tF11
nsert INSERT
Remove DELETE
Segment P
Snap point
Snap all
Move to ongin
Horizontal
Vertical
Finish RETUEN
Continue

7.3 Move

(F11) Move will change the selected segment to a "Move" and it will become invisible just
as if a move was implemented during the creation of the object.

7.4 Line
(F10) On a curved line, this will change a Bezier curve into a straight line segment.
7.5 Bezier
(Shift-F10) will turn a straight line segment into a Bezier curve.
7.6 Closed
(Shift-F11) will change an open object into a closed one as if created as a closed object.
7.7 Insert
(Insert) will add an extra construction point in the middle of the chosen segment.
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7.8 Remove

(Delete) will remove a construction point selected by adjust clicking on that point.

7.9 Segment

Segment leads to a dialogue box showing the parameters of the selected segment with its
start and end co-ordinates. Of these only the latter may be changed through the box.

Current segment

Type | Line
Start | +3.00cm ,[+19.60cm

End +5.00cm| |, |+19.20cm

Length | 2.0d4cm
Angle | -11°

cmncct] | Apply )

B

7.10 Snap point

If an object is created with Grid lock off, this option can cause a selected point to snap
onto the grid.

7.11 Snap all
This will snap all the points of a selected line or object onto the grid.
7.12 Set origin

For this to work, "Allow re-positioning" and ideally "Show origin" need to be set in the
Drawing>rulers>origin dialogue box (3.2.3).

Adjust click on the point at one end of a segment, select "Set origin" from the edit menu
and the origin of the drawing will be moved to this point.

If Allow re-positioning is selected, the origin can be set anywhere on the drawing by
holding down the shift key and clicking adjust at that point.
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© Origin marker

7.13 Move to origin

An object is moved such that a selected point is positioned on the origin. However, the
object will not be locked to the origin, and if the origin is subsequently moved, the object
will stay where it is.

7.14 Straighten
This will cause a curved line to appear straight. It, however, will still be a curve, without
curvature. It will have the Bezier adjustment points and be capable of having its shape
edited as a curve.

7.15 Smooth

If the selected segment of a line is a curve, either the first or both control points will be
adjusted to generate a smooth curve

e
] ! P
B il
]
3 - | : &
- |
Bezier curve showing section to be smoothed Bezier curve showing the effects of smoothing

7.16 Horizontal
The selected point is moved so that both ends of the selected segment are horizontal.
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7.17 Vertical
The selected point is moved so that both ends of the selected segment are vertical.

7.18 Finish
(Return or Enter) completes editing and closes the menu.

7.19 Continue
This allows the continuation of an existing path. If a completed line, for example, is
selected and open for editing, selecting Continue will allow further segments to be drawn
onto the end of the line. These will be an intrinsic part of the original and it will not be as

if a new line object had been added on to the existing one. The new segment will always
be added on to the end of the existing object.
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8.1 Library (Shift-F6)

Libraries are an extremely useful feature. For example, when laying out printed circuit
boards, pads can be laid out for the pins of an integrated circuit, grouped and then stored as
one object in the library for reuse.

They can be used to store any type of object (except for text columns): standard symbols,
text fonts or clip art. They are shared between all drawings being worked on. Objects are
stored and accessed by name but only one library can be loaded at any one time. The
library is saved separately from any drawings, independent of any drawing, and the objects
pasted into any drawing.

Many libraries can be created for different purposes. For example, one might create one
for storing printed circuit board components, whilst another might be created with
architectural symbols.

Once a drawing has been opened, the library is loaded by selecting the library file from
wherever it has been saved.

8.2 The Library menu
Library
Store Ll B
Retrieve TTF6
Show... AW
v Resef layer
Paste scale P

8.2.1 Store To store an object in the library, it must be selected (in Select or Edit mode).
Open the "Store" dialogue box in the "Library" menu, and enter a name for the object. The
name can be up to 20 characters long, and may include any printable characters including
space. Press Return or click "OK" and it will be added to the library.

Note. If an object from the library has been used, the store dialogue box will show the
name of the object last used. This must be erased or modified or the object will be
overwritten with the new object.

Initially when OpenVector is first run, if no libraries are present, a default one will be
created but this will have no name and will need to be saved for future use (8.3.3).

8.2.2 Retrieve This allows stored objects to be retrieved from the library. The object is
chosen from the list in the open library window and when this option is ticked the pointer
will change shape to indicate library mode.

Alternatively the library tool from the toolbox may be used:
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When select is pressed the object will be placed on the drawing at that point. The object
will remain selected and the mode active to allow as many instances of the object to be
placed.

8.2.3 Show When using OpenVector, the keyboard shortcut Ctrl-W is usually more
convenient. This will open the library window.

In the example illustrated, the library sub-menu has been moved to one side to show the
library window. The top pane shows the names of all the objects available in the library
and this can be scrolled in the usual way. The lower pane shows the object which has been
selected in the upper pane.

= B4 Lib: Untitled * =

/
I OpenVector
File =
Object P
Save as:
Save library | =
Clear hibrary R L ﬁ'

/_\_,\ Delete object i r}l
Rename object | Cagios] J | Save J

Export object ]

.
Canart conients

Path object
View at 50%

EE

8.2.4 Reset layer When objects are stored in the library, they retain their layer
information. If the "Reset layer" option is set, the library object will be added on the
current layer. This should normally be selected. If this option is not set, the object will
remain on the same layer that it was on when it was added to the library. If this layer is not
defined in the drawing, the object will not be visible and will be unselectable.

8.2.5 Paste scale changes the size at which objects are pasted. For example, if a line
100mm is stored in the library, this would normally be 100mm long when repasted back
into the drawing. However, if paste scale is set to 50% the line will only be 50mm long
when pasted back.
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8.3 Library sub-menu As shown in the illustration opposite.
8.3.1 File This shows information about the library file. This is similar to (2.2).
8.3.2 Object shows details about the object currently selected.

This shows the details about the hexagon used in 6.7.

] About this object |~
MName [ Hexagon
Type | Path object

Bytes 132 Lu_verl 0
Si.EE:I 1.21em :-al 1. 40cm

Time | Mon 22-Feb-16 21:04

8.3.3 Save library Illustrated opposite saves the contents of the library as a library file. A
suitable name and location for saving can be chosen in the usual way. It probably makes
sense to store libraries in the same directory as the OpenVector application itself.

8.3.4 Clear library Completely clears the library, i.e. deletes all objects.
8.3.5 Delete object Deletes the selected object from the library.

8.3.6 Rename object Changes the name of the selected object. Edit the name in the entry
box leading from this option.

8.3.7 Export object Saves the selected object as a Draw file; used in the normal way.

8.3.8 Export contents In the example shown, this is greyed out. The library can store
other types of objects as well as vector objects (Draw objects). These include sprites, text
objects and JPEGs. When one of these is selected in the library, Export contents allows the
export of the object in its original format. Export object is still available and allows it to be
exported in drawfile "wrapper".

Libraries, of course, will need saving after changes have been made but this can be done at

any convenient time. If OpenVector is closed and the library has unsaved changes, a
warning message will be shown and the library can be saved.
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Existing libraries can be loaded into OpenVector by opening the folder where they have
been stored and select double-clicking on the icon representing the wanted library.
Alternatively, dragging the library icon onto the OpenVector icon on the iconbar will have
the same effect. Only one library can be loaded at a time but different libraries can be
loaded and used in the same drawing.

To merge libraries, drag the icon of one library file to the open library window of another;

its contents will be added to the current library and any objects with duplicated names will
be superseded by those in the merged library.
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9.1 The Arrange menu

Arrange
Rotate/Skew AR I
Flip L-R
Flip T-B

Scale/Transform S |
Change layer AL B
Smapto gnd MG
Size/Position AP |

9.2 Rotate/Skew (Ctrl-R) leads to a three-function dialogue box.

Rotate/Skew

Operahon
(® Rotate ) Hskew J Vskew

Angle

90.0| | degrees (@ Anticlockwise
| About origin _) Clockwise

lecell | OK I

9.2.1 Rotate rotates the objects about the centres of their own bounding boxes. Specify the
angle in degrees, and select "Clockwise" or "Anticlockwise" as required.
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Object rotated 45 deg Clockwise

9.2.2 H skew displaces each point of the object horizontally, a distance depending on the
height above or below the object's centre (so squares turn into parallelograms, etc.). The
limit on the angle in this case is £85° (think about tangents of large angles if you want to
know why).

Horizontal Skew 20deg anticlockwise

Clockwise displaces points above the centre to the right and ones below the centre to the
left, while anticlockwise does the reverse.

9.2.3 V skew does the same, but in the vertical direction.
9.3 Reverse L-R

Mirrors the objects left-to-right.
9.4 Reverse T-B

Mirrors the objects top-to-bottom.
9.5 Scale/Transform

(Ctrl-S) leads to a dialogue box allowing the objects to be scaled by a specified amount.
This can be expressed as a percentage or decimal as set in 3.2.2.
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For scale factors greater than 100%, selecting Enlarge makes the objects bigger, while
Reduce makes them smaller (obvious really!).

Equally, enlarge by 80% will make the object smaller and reduce by 80% will make the
object larger!

Scale/Transform
Faciors Options
Overall | 120%] | — @ || @ Enlarge ) Reduce
Hdim's | 100% | scale about origin
Vdim's | 100% P
Lines | 100¢% CmceIJ | Ok J

9.5.1 Transform Similar to "Scaling", but allows the scale factors for horizontal and
vertical dimensions, and line widths, to be specified independently.

In the above illustration, scaling is selected. Transform is selected via the lower button in
the left-hand section.

9.5.2 Scale about the origin Usually dimension scaling is applied about the object's
centre, but "Scale about the origin" has the same effect as scaling by dragging with origin
mode selected (4.1.6).

Any type of object can be scaled.
9.6 Change layer
(Ctrl-L) moves any selected objects onto the layer selected via the dialogue box.

In the example below the layers have been given names (3.3.1).

Change layer
: Standard
: Copper ...

: upper ...
: Compane. ..

[ S N S
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9.7 Snap to grid

(Ctrl-Shift-G) leads to a dialogue box which allows choice of which part of an object’s
bounding box should be snapped to the grid.

Snap to grr
Honzontal Vertical
@ Left @ Top
_) Hcent J Vcent
L’I-? Raght @ Bottom
Cancel | Dcfaultjl OK |

Note that if multiple points of the bounding box are selected as shown, the shape and size
of an object may be altered in order to fulfil the criteria.

When OK is clicked, this aligns the objects to the grid whether grid lock is on or not.
9.8 Size/Position

(Ctrl-Shift-P) allows the size and positioning of a single object to be altered.

Size and Position

Honzontal Vertical
Left B.00am | ) Top 6.20cm | o)
Width | 2.00cm| @\ Height | 1.80cm | (@
Right | 1000cm | ) || Bowom | 4.40cm | )

Cancel |CII{|

At most one each of the horizontal and vertical position and sizes can be selected and
altered. Changing the left, right, top or bottom position moves the object; changing width
or height scales the object about its centre.

9.9 Align

(Ctrl-J) leads to a dialogue box for specifying the type of alignment. Horizontal and
vertical alignment can be selected at the same time if required; the specified point on each
object is aligned to the same point on the left-most (for horizontal alignment) or lowest
(for vertical alignment) object.
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Alignment
Honzontal Vertical
@ Left ® Top
) H cent ) Voent
) Right ) Bottom
Cancel Default | OK |

Unaligned objects Objects after top left alignment
In the above, the objects have been both top and left aligned. If only top alignment had
been set, the items would have remained separate, the smaller box just being moved

upwards until its top was aligned with the top of the other object.

9.10 Distribute

Distribute
Honzontal Vertical
(@ Left ) Top
_J) Hcent ) Veent
) Right ) Bottom
Cancel ! Defauli | OK I

This leads to a similar dialogue box, except that only one option can be selected at a time.
Three or more objects may be selected for distribution. The outside objects are kept in
position, and the objects are moved so that the specified points are spaced evenly between
the same points on the left-most and right-most (for horizontal distribute) or the highest
and lowest (for vertical distribute) objects.
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] C

Initial random distribution

Equal spacing

- Left side horizontal distribution

Equal spacing

Honzontal eentre -distrbution-

Equal spacing

Right side horizontal distribubion
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9.11 Space/Pack

This leads to a dual-function dialogue box.

Space/Pack
Action Direction
@ s pace out (@ Horizontal
_J) Pack together ) Vertical

Cﬂncell | OK |

With "Space out" selected, the objects are moved in a similar way to Distribute, but so that
the space between the objects is constant rather than the reference points on the objects
being spaced equally. Note that the extreme objects are not moved, only intermediate ones.
There must be enough room between the two extreme objects to fit in all the others
without overlapping. This option is not available if only two objects are selected.

With "Pack together" selected, the objects are moved so that their bounding boxes fit
together without overlapping, starting from the left-most or lowest as appropriate.

Imitial random distribution

Spaced out horizontal

. Packed honzontal
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10.1 Dealing with Text

The Text tool ll

Nothing so far has been said about the use of text, but OpenVector is capable of using and
manipulating text in a variety of ways.

To enter text, select the text tool from the toolbox. The pointer will change to a caret, and
this should be positioned where the text is required. Simply typing will cause the text to
appear on the drawing and entry is completed by pressing the Return key.

Multi-line text can be created by pressing Insert or the Tab key instead of Return, at which
point the caret will move down to the next line below (but see Choices 13.4.4). The
appearance of multi-line text can be achieved by typing single lines and grouping them
together, but editing is then not so easy.

Text can also be imported from a wordprocessor. If text is exported as a text file and the
file dragged onto an open OpenVector window, the text will be added into a "Text area".
This will be created automatically when the file is dragged in. Initially an error box will
appear "Text does not have standard header, using default one."

Editing of normal text (text areas behave slightly differently — see 10.2) can be carried out
by selecting the text then entering edit mode from the toolbox just as with graphics. When
the adjust key 1s positioned over the text and pressed, the caret will appear within the text
and normal text editing, with cursor and delete keys, as well as all the normal characters,
will be active. There are some additional key presses available.

Ctri-(left cursor key) and Ctrl-(right cursor key) move to the start and end of the
current line.

Ctrl-(up cursor key) and Ctrl-(down cursor key) moves to the start or end of the text.

Ctrl-Copy (not present on all keyboards). If not at the end of a line, this deletes
forwards from the caret position to the end of a line. If at the end of a line, it
deletes the "new line" and joins the following line to the current one.

Ctrl-U, if not at the start of a line, deletes backwards from the caret position to the start
of the line. If at the start of a line, it deletes the "new line" and joins the current
line to the previous one.

CTRL-X deletes the whole text.

TAB create a new line.

Various effects can be created with the same editing and arranging tools used as for
graphical objects.
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This is Text Th]S]S TCM ﬁf/f/ﬂ//

Normal text Stretched text Skewed text

In the examples above, the normal text was stretched vertically by dragging the centre top
tab of its bounding box upwards. This was then skewed 20° from the arrange menu (9.2). It
should be noted that font, size and colour can be changed retrospectively for text already
laid down, by selecting the text and going through the Text/area menu to make alternative
selections.

10.2 Text areas
Editing/arranging text areas is a little different. If the text is exported out as a text file

(File>Export>text area (2.5)) the header, added when it was imported, can be seen if
loaded back into a text editor. These are typical header commands.

\I'1 Declares it as a text area

\F 0 Trinity.Medium 12 Font O is Trinity.Medium, size 12 points
\AD Use double (full) justification

\L 12 Line spacing is 12 points

\P 12 Paragraph spacing is 12 points

\0O/ Use font O for the following text

There are various commands that can be used/changed from within your text editor, which
will be acted upon when the file is loaded back into OpenVector. If the original text area is
selected when this is done, it will replace the original, otherwise it will be added as a new
piece of text. All commands must begin with \. and should end with /, although not all
commands require it. All commands are case sensitive so capitals are required.

Start \!'1 first line of a text area file; must be present

Justification \AL ,\AR,\AC,\AD justify left, right, centre or full

Columns \D <number> sets the number of columns e.g.\D 2/

Defines font \F <font number><font name><size><width> specifies a font

style attached to a font number. If <width> is omitted, the same
size will be used for width and height.

Specify font \<font number> The font to be used for the following text. This
must previously be defined as above. e.g. \F O Trinity.medium 12
or \F 1 Homerton. medium 12 depending on the fonts available
on your machine.
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Paragraph

Margin

New line

underline

Underline off

Vertical move

Soft hyphen
Insert backslash

Text colour
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\L <line spacing> sets the line spacing in points e.g. \L. 14/

\P <paragraph spacing> sets the extra spacing for a paragraph in
points e.g. \P 12/

\M <left margin> <right margin> sets the margins in points e.g. \M
44/

\ return starts a new line.

\U <position><width> turns underlining on. Both values are in
units of 1/256 of the current font size e.g. \U -20 16/

The position can have any value from —128 (below the base of the
character to 127 above. Width can have any value up to 255.

\U 00 or\U

\V <vertical move> moves the following text vertically by the
specified number of points to create superscripts (+) or subscripts
(-) e.g.\V -6/ To print the word "superscript" above other
characters in a line \V 9/ superscript \V -9/ This would normally
be used in conjunction with a font specify command, using a
different font number, which had a smaller font size to the main
font.

\- shows were a word may be split when arranging text.
\\ allows a back-slash to be inserted in the text.
\C <red> <green> <blue> sets the colour of text according to

RGB values. Each number representing a percentage.
e.g.\C 100 0 0 would select 100% red.

Background colour \B as text colour

Text areas can be moved, copied, deleted and replicated as other objects but only a limited
set of options will be shown to be available from the arrange and text/area menus.

In the main menu, shown earlier (1.4), the option Text/area is shown greyed out. This is
because the text tool had not been selected at that point.

Once in text mode, the Text/area menu can then be selected.
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10.3 Text/area menu

Text siyle
Text font... AT
Textsize  AfIS B
Text colour AMC b
Background P
Layout MK |

Smart quotes
Eeset quotes

Setas default
Apply default

10.3.1 Text font Selecting text font will bring up a dialogue box allowing the font and
style to be chosen. The fonts available will depend on the fonts you have loaded onto your
machine.

Text font
Typeface Style
3 FAILTITLY
vaioo [ [0
TRAMP e
g 1 |Medum.Itahc
University =
Vogue '
Try | abudefghijklmnopqrs-m!.'wxyzl
Cancel I | Ok l

The highlighted fonts are the ones currently selected and fonts are chosen by scrolling to
the desired typeface and selecting. The available styles will then be shown (not all fonts
have the same available styles) and be chosen. Clicking on "Try" will show what the font
looks like.
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10.3.2 Text colour Three different colour definitions are available for selecting the text
colour. The default is RGB, but CMYK and HSV are also available by selecting the button
in the top of the colour select window.

10.3.2.1 RGB red-green-blue As used by colour display equipment where colour is seen
by generated light. The colour can be chosen by clicking anywhere in the colour box and
the chosen colour will be shown in the small window below it, or alternatively, by
choosing a percentage of red, green or blue in the small windows to the right of the colour
box. Either a percentage value can be entered directly into the box or it can be varied using
the up-down pointers to the right. A third option is the block of colour squares to the
bottom right. Selecting one of these will choose the colour. This method is more suited to
older machines with screen modes having a limited colour pallet. It is often wise to pick
from these colours if the machines used by recipients of your documents may be so
constrained.

Text colour

| @ RGB ) CMYK ) HSV

| - [ ORed | B84|l/A@
‘ . ) Green | 890| /. 8%
| (@ Blue 0.0 /A %
|| — T m =

Nonge Cancel J [ OK J

S
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10.3.2.2 CMYK cyan-magenta-yellow-black (key) This is the standard used in colour
printing, items viewed by reflected light. Colours can be chosen by dragging the slider
within the horizontal "thermometer" box, typing in a percentage, or using the up-down
pointers. As before, there is the set of coloured squares and the colour chosen will again be
shown in the small box to the bottom left.

Text colour

_) RGB (@ CMYK _) HSV

Cyan [ po| 7/ he
Magenia ( 0.0 #_\%
Yellow | 0.0 /N %

Black [m——— | 1000 /_\ %

- Mome Cancel J [ Ok J

10.3.2.1 HSV hue, saturation, value This is a colour model that describes colours (hue or
tint) in terms of their shade (saturation or amount of grey) and their brightness (value or
luminance).

The HSV colour wheel may be depicted as a cone or cylinder. Instead of Value, the colour
model may use Brightness, making it HSB (Photoshop uses HSB).

Hue is expressed as a number from O to 360 degrees representing hues of red (starts at 0),
yellow (starts at 60), green (starts at 120), cyan (starts at 180), blue (starts at 240) and
magenta (starts at 300).

Saturation is the amount of grey (0% to 100%) in the colour.

Value (or brightness) works in conjunction with saturation and describes the brightness or
intensity of the colour from 0% to 100%.

As with RGB, there is a window. Depending on which of the buttons (hue, saturation,

value) is pressed, clicking in the window will select a value for that parameter. Again there
are the small writable windows with up-down arrows and the coloured squares.
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Texpcolour
L]
) RGB ) CMYK (@ HSV

=

) Hue
) Saturation

(® Value

.5
/A %
[N %

ma

Cancel J[

OK

10.3.3 Background. This is really to do with how things appear on the screen, when
coloured anti-aliased text is placed over a coloured background, and it affects the colours
of ant-aliasing pixels used. Background should normally be selected to match the

background over which the text is to be placed.

10.3.4 Layout The text layout menu will be familiar to anyone who has used a

wordprocessor or similar software.

Cancel I

Text lavout
Justify Options
Z| @ Left | Horizontal keming
=| ) Centre | Background blending
E ) Right Line spacing | 110%]

[Lox )

For single lines of text, setting justify will have no meaning, though it might move slightly.

However, it will affect multiple lines of text.

Horizontal kerning can be set for any text object if the font supports it.
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10.3.4.1 Background blending This affects how a font reacts with the background it is
placed on. With blending on, hard edges are softened and merged gently into the
background. The effect is only really noticeable with coloured text against a coloured
background.

_Blending Off . . ~ Blendmgon

10.3.4.2 Line spacing determines the spacing of the lines as a proportion of the font size.

10.5.5 Smart quotes Although the RISC OS outline font sets include smart quotes, there is
no key on the keyboard to be able to use them. They can be applied using ALT and
entering 0144 and 0145 from the numeric keypad (singles) or 0148 and 0149 (doubles),
but setting this option means they are automatically applied when the situation is
recognised. The option is only available when editing text.

“TEXT" "TEXT"

Smart quotes ~ Smart quotes
on off

10.5.6 Reset quotes restores to normal.

10.5.7 Set as default This sets the settings, as just set up, into the default settings for text
within this document.

It also allows the parameters of a selected item to be set as the default.
10.5.8 Apply default This provides a quick method of setting any previous text, that is

selected, to have the default setting. If the default has been set from the parameters of one
object this can be used to set other objects to be the same.
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11.1 Path/mask

This menu becomes active the moment any of the drawing tools are activated, to set up the
parameters for the drawing of the object. It is also active when an existing object, other
than text, is selected.

Path style
Line/Outline AfiL
Fill/Overlay  AfIF B~
Line width AW
Overlay width ATV B~
Line pattern -
Cap/Join/Wind ATJ P

Setas default
Apply default

The first two lead to dialogue boxes relating to colour, the same as the text colour boxes.
Line and fill colour need not be the same.

11.2 Fill/Overlay

This allows an object to be filled or overlaid with a colour but, for a fill, that object need
not be an enclosed space. It can, just as easily, be applied to an open line. A fill is applied
by un-ticking the box that says "none". During the "create" phase, once selected, it will
remain on for all objects created until "none" is ticked.

Drawn line _ _ _ _ . ~ Drawn lire with fill applied

11.3 Line width

Line width can be set by selecting one of the preset widths or typing into the box. Fine is
very thin and may not show up properly when printed. It is always advisable to choose a
defined width. Remember, 1pt is only 1/72". As shown here, the width units are points but
this can be changed via the Drawing>Rulers-Misc units dialogue box (3.2.2). For example,
if millimetres has been set for units in this dialogue box, selecting the 3pt preselect here
will show 1.6mm in the small writable box.
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Line width

Preset

Thin I pt

Y pt 2pt

apt ipt

0.00p{ | Cancel | | oK |

11.4 Overlay width

The Overlay box selects whether the line is filled or overlaid. With overlay, the line is
instead overlaid with a different colour. This can give the appearance of two parallel lines,
as may be required when drawing a map, for instance

The default overlay width is 0% and this will mean that the line is filled. If the number is
set to any other figure, up to 90%, the line will be overlaid as below. The percentage sets
the width of the overlaid line in proportion to the width of the line being overlaid. Some
experimentation may be required to get the desired effect. The box on the Fill/Overlay
dialogue box needs to be unticked.

10point black line overlaid 50%: with white

11.5 Line pattern

Line pattern has already been mentioned earlier (3.4). This dialogue box is a convenient
method of selecting the pattern required.
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11.6 Cap/join/wind

The caps, joins and winding rules box:

Caps, Joins & Winding rule
Start cap Comers
@ Butt _J) Round @ Mitre ) Round
_J) Square ) Triangle ) Bevel
End cap Trnangle
(@ Buit _) Round Width
_J) Square ) Triangle Length 2
Winding rule
_J) Non-zero (® Even-odd Cancel J I OK J

Caps sets the way in which the ends of open paths and line joins are displayed. The join,
starting cap and ending cap can all be set independently, and the size of the triangle cap
controlled.

Butt caps
Square caps

Found caps

Triangle 2:2

In the examples above, the triangle was set for 2:2. The length and width are both twice the
width of the line. The red line shows the point at which the line was ended.

With butt caps the line ends dead on the point. With square caps a portion is added to the

end equal to half the line width. With round caps a rounded end is added with radius equal
to half the line width.
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Joins>corners This affects what happens at corners of objects.

Bevelled Bevelled

Winding rule is used for areas (parts of the diagram bounded by lines) for which a fill
colour has been set. Even-odd means that an area is filled if it is enclosed by an even
number (including zeros) of areas. Non-zero winding fills areas on the basis of the
direction in which the paths were constructed. If an equal number of paths in each
direction surround the area, it is not filled, otherwise it is. Usually the even-odd rule is
used.

The objects above were created as one path. The objects were drawn by drawing the outer
in a clockwise direction, "moving" to draw the left-hand "hole" in a clockwise direction
and then "moving" to draw the right-hand hole in an anticlockwise direction. The left-hand
object was filled with even-odd winding and the right-hand with non-zero winding.

If the middle object is studied, it will be realised that the right-hand "hole" is enclosed by
one path going anticlockwise and the outer path going clockwise. It is enclosed by an
equal number (two) of paths going in each direction, so is not filled. On the other hand, the
left-hand "hole" in the same object is surrounded by two paths going in the same direction.
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See also path reversal (12.12).
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12.1 The Special menu

Special
Text to path
Explode text

Bounding box.., "X

Replicate. .. fiFs

This shows the upper part of the special menu when text is selected (does not apply to text
areas). The rest of the menu is greyed out as it is not applicable.

12.2 Text to path

A piece of text can be converted to a path object(s). There are some operations which
cannot be performed on text. However, by converting text to a path object these become

available.
[ext lext Text 1
Basic text object A A, converted to path B, with fill/overlay C, fill/over lay
' ' ' ' Line outline D.5pt " imyellow ' ' 50% °
Object B Object C

The above shows examples of some effects. The text was 48pt Homerton and, after
creation, all objects were distributed by horizontal centre and each row top aligned. The
commentary text was centre justified during creation.

When text to path is used, the whole object is converted to a path and the letters cannot be
edited individually.

12.3 Explode text
This allows the text object to be converted to a group of individual text objects. Initially
this will be one "group" but it may be "un-grouped" so that each letter can be worked on

individually. Initially they are still text objects so text editing features apply, but they can
individually be converted to path.
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Te*t Tgt

In the second example (left-hand), the same text object was exploded. The first letter T
was rotated by adjust dragging the corner of its bounding box. The letter e was stretched
vertically by select dragging the centre tab of the upper side of its bounding box. The x
was rotated as T and the final t left untouched. The group was then grouped and copied
before moving to become the right-hand object. After un-grouping, the T was converted to
path and edited as C in the text-to-path example, above.

12.4 Reset object

This will restore a scaled or rotated sprite to its original scale and rotation.

It can also restore a rotated text object to its original horizontal position.

12.5 Special menu - path

Special
Bounding box... AMTX
Replicate. .. TF8
Radiate. .. AF8
Eeverse path N
Split subpaths
Split to lines
Stroke path
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This shows the special menu when path has been selected. Note that some operations are
also included in the text menu.

12.6 Bounding box

This creates a rectangle around any object or group of objects. It is a separate path object
and the option leads to a dialogue box that allows the selection of the spacing between the
object and the bounding box to be selected.

Boundmg box

Separated by ﬂ.}lﬁvr.:ml

_l Group with onginal

Cancel | | Create |

As with the path width dialogue, the units are those selected in the miscellaneous units
option in the rulers dialogue box (3.2.2).

In the example shown, the separation was set to 1cm and the group option was selected. If
no value is selected the separation will be zero.

This may be used to draw a frame around an object or to set new limits to its bounding
box. It is important to note that the bounding box is a separate object and, if un-grouped,
can be treated as such. It can be moved or overlaid, have its line width or colour changed
and so on.
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The above shows a bounding box created round a group of objects; separation 0.5cm.

12.7 Replicate
Replicate

Action
(@ Copy Object Statie = Dynarmic
) Create Static Dynamic = Objects

Amend Stati Replicate = Ongmal
Type Extent
(@ Horizontal H ¥

;
_) Ventical Thbee 2 '
) Diagonal Offset| +1.00cm +1.00cm
_J) Matrix
Cancel | | OK I

12.7.1 Replicate — copy object behaves like the standard copy, and produces as many
copies of the original as set in the number box. These can be separated and worked in any
desired way. It is important to note that replicates are unique to OpenVector and cannot be
understood by any other application which can import drawfiles. However, Dynamic>
Objects allows them to be converted into objects that behave exactly the same as other
objects, and these can be seen by other applications.

Type controls the way the replicate is created and the extent, how far apart.
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0 MOL

Origmal - Copy Horizontal - Objects separated

c n o5 o« v oz =hkd w o= ox Kl K34
o 000 O O 000
Q- D s DY

Original Replicate horizontal - Replicate vertical Replicate diagonal © Replicate matrix
3, lem spacing 3, lom spacing 3. lem spacimg 3, lem spacing
i i gach direcnion each direction

12.7.2 Replicate — create static Produces replicas that are inextricably locked to one
another. They cannot be separated and any operation treats them as one object for the
purpose of editing. When rotated, the originals are rotated about their own axes, the whole
is not rotated.

Original - Static horizontal - Objects rotated and.
stretched

If the original is a single, un-grouped object, when editing, only the original can be edited
and any effects affect all items within the replicate. If the original is a grouped object,
editing cannot be performed, only arranging can be carried out. To perform editing on a
grouped replicate, it is necessary to convert the replicate back to the original, carry out any
editing and then re-replicate as required.
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K
| |
Omnginal - * Replicate : : * Editing - : Y Result

If the replicate is selected and the replicate menu brought up again three previously greyed
out buttons are available. Amend Static, Static>Dynamic and Replicate>Original.

12.7.3 Amend static The offset and the number of replications within the object can be
changed.

Original. . Static, honizontal, 3 at Ammended to two.
lcm offset at 1.5cm offset

12.7.4 Replicate>original reverses the process and the original object will be restored.
12.7.5 Static>dynamic This converts the static replicate into a dynamic one.

Dynamic replicas behave as static replicas except that individual objects within the
replicate can be separately moved and scaled. To do this the replicate is selected in the

usual way.

Double-clicking adjust over one of the objects will allow it to be moved or scaled using
the select button or the menu. It will seen from the adjust and arrange menus which
operations may be carried out.
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Once in this editing mode, using the select button a different object can be chosen. Using
the adjust button, once one of the objects has been selected for editing, allows multiple
objects to be selected. Multiple objects can also be selected by dragging a box around them
using adjust. Multiple objects may be aligned, distributed, spaced and packed. Individual
replicas can also be copied and deleted.

Once they are turned into dynamic replicas, it will also be noticed that Dynamic>Objects
becomes available when the replicate dialogue is called up again, over a dynamic replicate.
Selecting this turns the replicates into single separate objects that can be edited and
arranged individually. They are no longer the parts of a replicate.

Once turned into objects they can be seen by other applications using drawfiles as
mentioned earlier.

12.8 Radiate

Radiation can be viewed as specific form of replication. Only single path objects can be
radiated, and radiate allows an object to be replicated around a fixed point.

The default, shown here as opened for the first time, will cause eight replicas to be created,
45° between them about the centre of the original object. Clockwise or anti-clockwise,
affects the order in which the replicates are formed but this is only significant when the
result is overlapping objects

Radiate
Extent Centre

Number | 8 _‘_|7_|—_r|
Angle (°) | 450

@' Clockwise _rl |7 _rl
_) Anticlockwise - |

Action

(@ Create radiated path Cancel |
Amend radiated path =
Circle I

Radhate = I.J:._'!-xl‘?
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The left-hand figure shows the radiation of a simple line using the default settings. Only
four objects are visible even though eight were created because 45° separation puts four on
top of the other four.

In the right-hand figure, a triangle has been rotated about its lower corner. The left-hand
rotation was done clockwise, the right-hand anticlockwise, all other settings being the
same. The difference in how the triangles overlap can clearly be seen.

An object can be radiated around any of its nine points by selecting the point in the
"centre" dialogue box.

When circle is selected, the rotated copies will always form a complete circle. The angle
will automatically be chosen as n/360, when the required number of copies, n, is entered
into the number box and "circle" "selected". If, on the other hand, an angle is entered into
the angle box and adjust used over "circle" the number of required copies will be filled in
automatically.

i

Original - * 5 Radiates to circle - Radiates at 10 deg
to circle

Radiates behave in a similar way to static replicates. They can be moved, scaled, ordered,
arranged and rotated. Editing results in an edit of the original which is then transferred to
all radiates.

Original During edit REesult of edit
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Also, like replicates they cannot be read by other applications unless turned into objects
first.

12.9 Skeletons

Skeletons are empty replicates. They have the original object removed and can be used to
produce new replicates from other objects. They can be saved for reuse in other documents
but are unrecognised in any other application. The skeleton dialogue box is available when
a replicate is selected. The box has only one option available and that is to extract the
skeleton and the original object. When this is done, the original object appears, selected,
and there are a series of empty bounding boxes surrounding it. The Skeleton will be static
or dynamic, depending on the type of the original replicate and the same editing
restrictions apply. They can also be changed from static to dynamic using the replicate

menu.
Skeleton
Action
(® Extract skeleton and original object
"' i":!"l;ju "'I'-.i.':.i.'ll 1 L | |i_‘- L Y II"'_-Ir"'i'I ]
Apply skeleton 1o object (resize skeleton)
Cancel | | OK |
Original object Matrix replicate 3x3 objects Skeleton and object extracted

3cm apart

The original object and the skeleton are completely separate and can be moved around
independently, even deleted without the other being affected.
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A Skeleton can be used to configure other objects. Once selected, the skeleton dialogue
box can be brought up again and two operations are now available. One resizes the object,
the other the skeleton. In the example below, the dynamic skeleton from above has been
edited and then applied to a new object, a simple six-sided polygon. The skeleton parts are
"separated"” for editing by double-clicking adjust over the Skeleton. They are "put back
together" by double-clicking select over the skeleton.

L
|_
o
(O

The operation is carried out quite simply by selecting the skeleton and object, using select
then adjust, then opening the dialogue box to select the option and perform the action. In
the above, the option to resize the object was chosen and the polygon is resized to fit the
size of the outlines in the skeleton.

12.10 Mask

Mask allows one object to be shaped by another. It will be seen that the menu has two
options for creating masks, Create true mask and create substitute.

Mask

Action
(i Create true mask

) Create substitute

Dissolve mask

Options
_I Centre objects

Cancel | | OK |
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An object created with "true mask" cannot be seen by other applications.

Using the option "create substitute” produces an object having separate parts, which can be
seen by other applications. When it is selected, the status bar along of the top of the
OpenVector window, will show "group of three objects selected", and if ungrouped and
parts are moved it will be seen that there are a filled square with a window representing the
visible area of the sprite, the complete sprite itself and the original ellipse laid upon it.
Thus we reveal the original sprite and the original ellipse used to create the mask. Its
bounding box shows the true size of the original sprite.

A object created with true mask, when selected will show as "mask object” and its
bounding box extends only to the limits of the visible image.

In the example below, a sprite 1s taken and masked by an ellipse. The ellipse is created and
then laid over the top of the sprite. Both objects are then selected and Mask is chosen from
the Special menu.

| Drigiml Sprite | - - | | | - Mask ébjﬂct'crﬂmé{i

‘Mask laid over Sprite -

Mask activated
12.10.1 Dissolve mask simply removes the mask from a masked object.

12.10.2 Centre object will centre the mask over the object to be masked if not done
already via the align tool.
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12.11 Interpolate

Interpolate can produce some interesting effects by creating intermediate objects between
two similar objects. The objects must be single path objects, not groups, and contain the
same number of segments.

In the example below, of a square interpolated to a triangle, a triangle clearly has fewer
sides, hence segments, than the square. To produce the effect, the square and triangle
where generated and the triangle was edited as follows: Two ends of a segment were
selected thus highlighting the segment, and then the insert key was used to place an extra
point in that segment, thus creating an extra segment. With both objects selected the
interpolate tool was used with five interpolations selected.

12.12 Reverse path

This does exactly as expected. The end points are swapped.
One use for this would be controlling how objects are filled — see winding rule earlier

(11.6)
i ]
_ S ] =
c s o u
12.13 Merge paths

Merge paths allows a number of separate path objects to be merged into one path. Moves
are inserted where required. The example below makes use of the path merge facility and
also the interpolate command. As stated above, interpolate cannot be used on grouped
objects, but by using the path merge command a single path object could be generated

The object on the left was first created using individual elements for cylinder, piston, crank
and wheel. It was then grouped (for convenience) and copied. The copy was moved across
to the right, ungrouped and edited to show the piston as having apparently moved. With all
its components selected, merge paths was used to turn the objects into one path. The left-
hand object was then ungrouped and similarly merged. With both selected, they were
interpolated by five.
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Of course, this is not a true representation because the end of the con-rod does not move
around the circle but subsequent manual editing could correct that.

12.14 Split sub-paths
This breaks up a merged path object into its original separate paths.
12.15 Split to lines

This option splits a path so that each segment becomes a separate line.

12.16 Stroke path
Stroke path turns a path into a filled outline, which can be clearly see when Edit is

selected. The points can be dragged out in the usual way to change the shape. In the
example, the original line was 5pt wide.

o
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13.1 The Choices menu

There is a further menu not visible on screen, and this is to be found by clicking menu over
the icon on the iconbar: the Choices menu.

OpenVector
wo__
Choices. ..
Library. ..
Reload fonts
Quit

13.2 Info

This gives details about the program itself, including the version number, which is useful
to check if the latest version is installed.

o o About this program =
MName [ OpenVector
Purpose [ Object-orientated drawing
gaion Originally © Jonathan Marten.
Additions by <spellings.net>
and Christopher Martin.
Version [ 3.46 (24 Jul 2015)
Licence
Released under the GPL; no warranty.
See the file COPYING for details.

13.3 Choices

The Choices menu allow adjustment of some miscellaneous settings which, once chosen
and saved, will be used in future.
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13.3.1 RISC OS colour picker 4Mation had another program called Poster. This had its
own system for choosing colours and, if Poster is installed, this could be used instead of
the standard RISC OS one. This had most benefit prior to RISC OS 3.5.

Choices

Options

I? RiscOS colour picker I:f’- Auto paper size
|V Display while dragging | Outline dragging
_| Confimm file overwrite I? Show menu kevs
_| Confirm delete many I? Show tool tips
_| Ofter JPEG conversion I? it after printing

Compatibility... | Colours... |

Cancel | Save Set

13.3.2 Confirm file overwrite checks if you already have a file of the same name that you
are saving with, and asks for confirmation before overwriting that file.

13.3.3 Confirms delete many If this is selected, the program will ask for confirmation
before deleting, if you have more than a certain number of objects selected. Note it is
possible to reverse the action of one "delete" and one "delete" only.

13.3.4 Offer JPEG conversion OpenVector can load, work with and save JPEGs, as can
many newer RISC OS applications. However, some older applications cannot, so they
need "pictures" in a format they can use. Impression and its variants, a widely used and
much loved desktop publishing program, is one example. (After a long period with nothing
happening, this has now been picked up by an independent developer and is being brought
up to date as Impression-X.)

All RISC OS applications, by design, understand Acorn's bitmap filetype, the sprite. This
option allows OpenVector to undertake the conversion of any JPEG into a sprite.

13.3.5 Auto paper size This allows OpenVector to automatically choose a paper size when
an object 1s loaded into it.

13.3.6 Outline dragging This feature was of most use on early machines with limited

processing power. Instead of having to repeatedly redraw the whole object as it 1s dragged
across the screen just a representative outline is shown.
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13.3.7 Show menu keys In all the screenshots of menus shown in this document, the
appropriate keyboard shortcut has been shown alongside each entry. If desired, this can be
turned off by unticking this box. In order for this to take effect, the choices menu needs to
saved, OpenVector quit and then restarted.

13.3.8 Show tooltips. When the pointer is hovered over a tool on the toolbox, its name
will be shown if this option is ticked.

13.3.9 Quit after printing Existing files can be printed by dragging them directly onto the
printer icon on the iconbar, as long as OpenVector has been "seen" by the operating
system. OpenVector will be installed to allow this to happen. If this box is ticked, the
application to quit after the document has been printed.

13.4 Compatibility
Choices
Compatibility
_I Make copies at front Drag select:
_I Merge at pointer ) Touch
|7 All control points (@ Enclose
| Multi-line text _) Centre

_I Old-style selection box

Colours. .. J Ophons. .. J

Cancel Save Set
_Caeel | save |

13.4.1 Make copies at front If this is selected, when copies are made, they will appear at
the front of all objects, otherwise they will just be in front of the original.

13.4.2 Merge at pointer When this is selected, a merged document — that is to say, a pre-
existing document — is dragged into the current documen, it will have its left-hand bottom
corner positioned at the position of the pointer, otherwise it will be positioned at the
bottom left-hand corner of the existing document.

13.4.3 All control points When selected, during the editing of an object, all its control
points are shown. However, in the case of some complicated objects, this can lead to a
very "cluttered" look. Unticking this reduces the number of points shown. However, when
a segment is selected, all the points relating to that segment will be shown.
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13.4.4 Multiline text In the section regarding the entry of text, it was stated "Multi-line
text can be created by pressing Insert or the Tab key, at which point the caret will move
down to the next line below". If this option is chosen, using the Return key generates a
new line as it would in a text editor. Completion of entry is then by using the Insert key. In
either case select will complete the create or edit.

13.4.5 Old style selection box This is for those who have used the program from an earlier
time and prefer the older style box.

13.4.6 Drag select This was explained under the select menu (6.3-6.5). It allows the
option to be set as the default method for every drawing made subsequently once the
choices have been saved.

13.5 Colour
The colour menu allows the choice of colour for various bits of furniture.
Simply by clicking over each box the colours will be cycled through.

Paper margin is shown if "Show pages" — "File>Print setup” (2.7.4) is selected.

Screen grid defines the colour of the coloured spots on the background.
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